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Introduction:

SignalMaster was developed under a United States Department of Health, National Institutes of
Health (NIH), National Institute on Deafness and Other Communication Disorders (NIDCD), Small
Business Innovation Research (SBIR) grant to Intelligent Hearing Systems, Corp. The purpose of the
grant was to develop an open architecture hardware and software system that will allow researchers
to conduct a wide range of studies involving multi-channel acoustic input and output for
psychophysical research and hearing aid development. The current system provides users with the
ability to develop their own processing algorithms by providing source code examples and the ability
to upload programs to the device and communicate with a user developed control program on an
external computer. The hardware provides two input microphone and two output speakers, analog
channels with up to 32 bit digital conversion resolution and is able to operate independently from
battery power. The system provides sufficient processing capabilities to perform real-time signal
processing with minimal delay (or latency) between input and output with various point-by-point or
batch processing capabilities.

SignalMaster is based on a Texas Instruments (TI) Digital Signal Processor (DSP), TMS320C6746.
For full specifications, see the SignalMaster Specifications section below.

Web Site: http://ohsspds.ihsys.info/

Signal processing modules are available online for download by users from the following web
address:

http://www.ihsys.com/ohsspds/index.asp



http://ohsspds.ihsys.info/
http://www.ihsys.com/ohsspds/index.asp

This site contains a list of documents that are available. The DSP source code documents (zip files)
start with the name “SampleDSPCode_” follow by a descriptive name of the type of processing.
These zip files contain all files required by the Tl code composer to modify the DSP program. IHS
provided executables can be used to upload any DSP code to the hardware.



Getting Started:

Your SignalMaster system doesn’t require any special drivers. Simply install the software from your
SignalMaster thumb drive. The thumb drive contains example programs and libraries required for
developing new applications.

Simply run the Setup.EXE application on the thumb drive:

SignalMaster v 0

Search SignalMaster o
~
Q Name Date modified Type Size
Software 8/10/2017 1:06 PM File folder
System 8/9 File folder
"= IHSGEN.ICO 1716 lcon 1 KB
&l Setup.bmp 5/17, 23 PM BMP File 162 KB
I " setup.exe 9/28/2012 10:14 AM  Application 1,428 KB I
| SETUP.INI 8/9/2017 10:10 AM  Configuration sett... 1 KB

After running the Setup program, press the start button to install the software to the C:\SignalMaster
directory:

 Sctup 530

SignalMaster - 1.00 R T|.|ET HEA|NG

Directory: ‘C:\SignﬂlMaslel ‘
Work Done: |

0% ‘
This File: | ‘

Files:

Disk Space
Free: 839,65 GB
Total: 987 56 GB

[]Up Date Only

(c) Intelligent Hearing System 1387-2012

It is highly recommended to install the software in the default C:\SignalMaster directory as all the CCS
example projects are pre-set to look for libraries in that directory. If you wish to install SignalMaster in
a different directory, you will need to modify the default compiler and linking directories in CCS.

The installation utility will default to C:\SignalMaster and contains the following subdirectories:

C:\SignalMaster\...
DSPProjects — containing sample DSP applications

PCProjects — containing sample PC application with their corresponding DSP OUTFiles (For the
source code, look under the DSPProjects directory of the corresponding project)
IHSC6748HW — containing software and hardware specific files



All PC programs developed require at a minimum the following files that are provided or can be
developed by the user:

1) MyProgram.EXE - Your application program.

2) MyDSPProgram.OUT — Compiled TI DSP program generated using TlI Code Composer.

3) SIGMASDLL.DLL — IHS DLL that provides DSP communication routines and ability to upload
programs into the DSP.

4) Out2rprc.EXE — Tl provided program (available from your SignalMaster distribution
thumbdrive) used by the DLL to convert DSP compiled OUT files to BIN format for upload.

5) IHSWIN.SYS — IHS License file that contain information about your hardware. The DLL uses
this file to determine if your hardware is available or not.

Using the provided DLL, you may develop PC based applications in any programming language you
like, as long as that language supports DLLs. The DLL will allow you to transfer data to and from the
DSP to your application program on your PC. It will also allow you to send user defined command

instruction to the DSP.

Before you can continue to develop any programs for SignalMaster, you will need to install TI Code
Composer Studio (CCS). The following section will walk you through the installation process.



Installing Code Composer Studio (CCS):

Sections:
e Installing Code Composer Studio

e Importing Projects

e Setting Up The User Interface

e Installing the Compiler

e Updating Project Compiler Settings

e Compiling a Project

e Loading and Running a Project

e Starting a New Project

e Selecting a New Work Space

e Code Composer Studio Compiler Settings (Advanced Options):



Installing Code Composer Studio:

1. Download the offline version of the Code Composer Studio (CCS) installer from
http://processors.wiki.ti.com/index.php/Download CCS

2. Begin installing the application. If you are greeted with a window like the one below chances are you’ll
be fine to just click Continue:  Note: If you do run into an error, as shown below, then turn off your
anti-virus and try again.

¥ Code Composer Studio v8 Setup - m] X

CCS Installation

The Code Composer Studio installer is checking for any preinstall dependencies. This may take some time

Please read the information carefully to determine if you need to take any action prior to continuing,

Starting dependency checks.
Operating System Check: Windows 10 -> OK

Installer Path -> OK

Unicode character Check -> OK

Anti-Virus Check - > We have detected you are running anti-virus software on this computer. To ensure no problems occur during the installation, it is
highly recommended that real-time file scanning be turned off before proceeding with the installation.

Pending reboot Check -> OK

Checking Windows Updates.

Done

Texas Instruments Continue

3. Now click Accept and Next:

License Agreement

Please read the following license agreement carefully.

TECHNOLOGY SOFTWARE PUBLICLY AVAILABLE

Copyright (c) 2016 Texas Instruments Incorporated
All rights reserved not granted herein,
Limited License Agreement.

This Limited License Agreement (“Agreement”) is a legal agreement between you (either an individual or entity) and Texas Instruments
Incorporated ("TI"). The "Software” consists of the following materials: (a) the materials identified as Tl proprietary software programs in the
software manifest for the software subject to the terms herein, and any “on-line” or electronic documentation associated with these programs, or
any portion thereaf (the “Licensed Materials"), and (b} the materials identified as open source materials or third party proprietary software in the
| |software manifest for the Software, or any portion thereof (“Public Software"). For clarification, your use of the Licensed Materials is subject to

| |the licensing terms contained in this Agreement and your use of the Public Software is subject to the separate licensing terms specified in the
applicable software manifest and/or identified or included with the materials to which they apply. This Agreement does not limit your rights
under, or grant you rights that supersede, the license terms of any applicable Public Software license agreement. By installing, copying or
otherwise using the Licensed Materials you agree to abide by the terms of this Agreement. If you choose not to accept or agree with these
terms, do not download or install the Licensed Materials.

Tl hereby grants you a world-wide, royalty-free, non-exclusive license under copyrights and patents it now or hereafter owns or controls to make,
have made, use, import, offer to sell and sell ("Utilize") the Licensed Materials. With respect to the foregoing patent license, such license is
granted solely to the extent that any such patent is necessary to Utilize the Licensed Materials alone. The patent license shall not apply to any
combinations which include the Licensed Materials, other than combinations with devices manufactured by or for TI (“Tl Devices”). No hardware
patent is licensed hereunder.

Redistributions must preserve existing copyright natices and reproduce this Limited License (including the above copyright notice and the
disclaimer and (if applicable) source code license limitations below) in the documentation andfor ather materials provided with the distribution.

® | accept the terms of the license agreement.
| ©'I do not accept the terms of the license agreement. Print
| Texas Instruments

< Back Next > Finish Cancel


http://processors.wiki.ti.com/index.php/Download_CCS

4. Click Next again:

&% Code Composer Studio v8 Setup
Choose Installation Location

Where should Code Composer Studio v8 be installed?
To change the main installation folder click the Browse button.
CCS Install Folder

c\ti ~ Browse

Texas Instruments
<Back | Next> | Finsh Cancel

5. Select C6000 Power-Optimized DSP when prompted, and click Next:

&% Code Composer Studio v& Setup
Processor Support

Select Product Families to be installed.

Description
O MSP430 ultra-low power MCUs

I SimpleLink™ MSP432™ low power + performance MCUs

O SimpleLink™ CC13xx and CC26xx Wireless MCUs

O simpleLink™ Wi-Fi® CC32x Wireless MCUs

[ CC2538 IEEE 802.15.4 Wireless MCUs

[ C2000 real-time MCUs

O TM4C12x ARM® Cortex ® -M4F core-based MCUs

O Hercules™ Safety MCUs

O Sitara™ AMx Processors

0 OMAP-L1x DSP + ARM9@® Processor

[ DaVinci (DM) Video Processors

O OMAP Processors

O TDAX Driver Assistance SoCs & Jacinto DRAx Infotainment SoCs

mized DSP

essors & C66x KeyStone™ multicore DSP

O mmWave Sensors




6. Enable TI XDS Debug Probe Support and Spectrum Digital Debug Probes and Boards, and click Finish:

Note: Allow internet access if prompted.

&% Code Composer Studio v8 Setup X

Select Debug Probes

Select the debug probes you want installed and deselect the debug probes you want to leave out

Description
[ TI XDS Debug Probe Support i

[ Blackhawk Debug Probes Drivers and support files for
Spectrum Digital JTAG debug
probes and development boards.

[TISelect Al Install Size: 1214.55 MB

Texas Instruments

<Back Next > Cancel

7. The application will now take some time to perform the installation... Wait until it finishes...

W% Code Composer Studio v8 Setup - a x
CCS Installation

Code Compaoser Studio is being installed on your computer

Installing... com.ti.ccstudio.c6000.feature.group,com.ti.ccstudio.c7000.feature.group,com.tixdctools_3_32.update.feature.group,com.ti.dvt2.graph.visua

feature registered ~
Installing com.ti.dsflash.win32...

Unzipping c/ti/ccsvB/eclipse/downloads/comi.ti.dsflash.win32_8.2.0.1409.zip
com.tidsflash.win32 installed

Registering com.ti.ccstudio.cloudagentwin32...

feature registered

Installing com.ti.ccstudio.cloudagentwin32...

Unzipping c/ti/ccsv8/eclipse/downloads/cloudagent_win_0.5.1463.zip
com.ti.cestudio.cloudagentwin3?2 installed

Registering com.ti.ccstudio.nodejs.win32...

feature registered

Installing com.ti.ccstudio.nodejswin32...

Unzipping c/ti/ccsvB/eclipse/downloads/node-8.11.1_win32.zip
com.ti.cestudio.nodejs.win32 installed

Registering com.ti.ccstudio.p2tool...
Installing...
com.ti.cestudio.idemain.feature.group,com.ti.ccstudio.workflow feature.group,com.ti.chromium.browser.feature. group,com.ti.ccstudio p2tool feat

ure.group

cstudio.c6000.feature.group,com.ti.ccstudio.c7000.feature.group..

dctools_3_32.update.feature.group..
ivt2.graph.visualization.feature.group,com.ti.dvt2.rov.feature.group,com.ti.dvt2.resource.explorer.feature.group.
rex.

.dvt2.trace.ccs.feature.group,com.ti.dvt2.trace.control feature.group com.ti.dvt2.analysis.suite.feature.group.

com.ti.cestudio.c6000.feature.group,com.ti.cestudio.c7000.feature.group,com tixdctools_3_32.update.feature.group,com.ti.dvt2.graph.visualization
feature.group,com.ti.dvt2.rov.feature.group com.ti.dvt2.resource.explarer feature.group,com ti tirex feature.group,com.ti.dvt2 trace.ces.feature.gro
up,com.ti.dvt2.trace.control feature.group,com.ti.dvt2.analysis.suite.feature.group

Texas Instruments Cancel




8. Click Finish:

&% Code Composer Studio v8 Setup — a X

CCS Installation ;
Code Composer Studio has been successfully installed

¥ILaunch Code Composer Studio
[#ICreate Desktop Shortcut

Texas Instruments

Finish

You have now completed the installation process for the interphase portion of CCS. There are still a few
more items to take care of, but now you can run CCS. To Run CCS, simple select the CCS icon on your
desktop or select from available applications:

T

| D Ee—— . e

Code Composer Studio v4
® Microsoft Edge Phok

DSP BIOS APl Documentation Partly Sunny

90° %

e DSP BIOS Getting Started Guide
I- { DSP BIOS Release Notes
.-H‘_ il Washington,...
- - . DSP BIOS User's Guide
Hill Climb
5 DSPLIB Release Notes Racing 2
b Free”

DSPLIB Software Manifest
DSPLIB User Manual

Migrating a DSP BIOS 5 Applica...

a8
B
7
¢]
e]
¢]
3
n

‘OMAPL138 StarterWare

& Back

Eearch the web and Windows

When running CCS for the first time, enter C:\SignalMaster\DSPProjects as the default workspace
directory.

w« Eclipse Launcher x

Select a directory as workspace

Code Composer Studio uses the workspace directory to store its preferences and development artifacts.

Workspace: | (SSEHEINERE S\ at ~ Browse...

+ Recent Workspaces
» Copy Settings




Importing Projects:

From within CCS:

1. Click File > Import...

2. Click to C/C++ > CCS Projects

3. Click Next

< SignalMaster_DSPProjects - CCS Edit - Sample200_ WaveletCompresso

File Edit View Navigate Project Run Scripts Window Help
New Alt+Shift+N >
OpenFile...
[, Open Projects from File System. £l
Close Ctrl+W
Close All Ctrl+Shift+W
Save Ctrl+S
[l Save As..
Save All Ctrl+Shift+$§
Revert
Move...
Rename... F2
Refresh F3
Convert Line Delimiters To >
& Print.. Ctrl+P
Switch Workspace >
Restart
v Import..
L Export..
Properties Alt+Enter
1main.c [Sample200_ WaveletCompressor]
2 IHS_Utilities.c [Sample200_ WaveletC...]
3IH5_Utilities.h [SignalMaster/...]
Amain.c [Sample100 Wavelet]
Exit
516
¥¥ Import a
Select
Y
Impaorts existing CCS Eclipse projects into workspace. H
Select an import wizard:
type filter text
(= General
v B C/Cr+
[E] C/C++ Executable
&% C/C++ Project Settings
121 CCS Projects
Existing Code as Makefile Project
(= Code Composer Studic
(= Energia
(= Git
(= Install
(= Remote Systems
(= Run/Debug
= Team
Y .
@ < Back Next > Finish Cancel




4. For “Select search-Directory:” Browse to C:\SignalMaster\DSPProjects. This will show you all
of the projects contained in the DSPProjects folder.

Browse For Folder

i —Ex
Select CCS Projects to Import r Select root directory of the projects to import
Select a directory to search for existing CCS Eclipse projects.
<A

Photos
(®) Select search-directory: || Browse.. Poland

Program Files
O Select archive file: Browse. Program Files (x86)
Discovered projects: \

Select All ~ | | SignalMaster

~ | DSPProjects
SampleD01_PointByPeintEcho

Refresh SampleD02_PointByPointEchoFilter
SampleD10_BlockEcho
SampleD11_BlockEchoFilter
SampleD20_CalibrationModule
Sample100_ Wavelet
Sample100_ WaveletTEST
Sample101_Shifter
Sample200_ WaveletCompressor

IHSCE7AxHW

Deselect All

[ Automatically import referenced projects found in same search-directory
Copy projects into workspace

Open Resource Explorer to browse a wide selection of example projects.

@ <Back Next > Finish Cancel

5. Click Select All: The dialog box should look similar to how it does in the picture below.

% Import CCS Eclipse Projects O X
—555
Select CCS Projects to Import E/L
Select a directory to search for existing CCS Eclipse projects. |
@ Select search-directory: | CA\SignalMaster\DSPProjects Browse...
O Select archive file: Browse...

Discovered projects

U Sample001_PointByPointEcho Select All
Sample002_PointByPointEchoFilter

Sample010_BlockEcho Eazail
Sample011_BlockEchoFilter Refresh
Sample020_CalibrationModule

Sample100_Wavelet

Sample101_Shifter

Sample200_WaveletCompressor

[[] Automatically import referenced projects found in same search-directory
[] Copy projects into workspace

Open Resource Explorer to browse a wide selection of example projects.

@ <ok Nect> Concl




6. Click Einish. The demonstration projects we supplied should now show in the project explorer
window.

¥¢ SignalMaster_DSPProjects - CCS Edit - Sample200_WaveletCompressor/main.

File Edit View Mavigate Project Run Scripts Window Help

B i Bif{-iPisis I RE" o
[ Project Explorer 52 2% ¥ = O |[gmainc 2 [gIHS Ut

L Sample001_Poi i 597/

ampl _PointByPointEcho 177

= Sample002_PointByPointEchoFilter 2 /)

[£5 Sample010_BlockEche 37/

(£ Sample011_BlackEchoFilter 4/

= Sample020_CalibrationModule

= Sample100_Wavelet
(£ sample101_Shifter
= Sample200_WaveletCompressor [Active

D0 NV B WSO O



Setting Up The User Interface:

We find that CCS by default has its windows arranged oddly. We therefore recommend the following
rearrangement for better ease of use. Drag and drop the respective tabs by clicking on the drag
marker until they are arranged as shown or personally desired.

Drag Tab Drag Tab

V% DSPProjects - Samplegd1_PointByPointEcho/main.c - Code Cgfnposer Studio . [s] X

Fle. Edn View Naghoie Project Run Scrpts. Windoy” Help File Editor

(=4 vidviQ~ ¢ il ROy Quick Access| | & | B
. Project Explorer E® ~ =] | mam:" =
TR T [ ettt =
4 Binaries 13 extern union inFuncData_union inFuncDataArray;
B Includes 14 extern union outFuncData_union outFuncDataArray;
& sMv2 15
& codecConfig.c 16
3 codecith 17 ALL Large Variables
(& FilterFunctions.c i* / Fadons
(& IHS_Utilities.c 20int Stim[2] [AUDIO_SAMPLES_MAX];
4 mainc 211nt MicRv[2][AUDIO_SAMPLES MAX] _attribute_((section(".ihsExternien")));
& Mainh 22short STest[AUDIO_SAMPLES MAX] _attribute_((section(".ihsExterntlen”)));
& mcasp.c 2
& PROTOCOLA
£ RingBufferfunc.c 2
> Vi :?nt main(void)
& Sample002_PointByPointEchofilter
S Sample010_BlockEcho Setup the DSP
& Sample011_BlockEchoFilter
& Sample020_CalibrationModule int sampling_rate;
3 Sample100_Wavelet int buffer_length;
& Sample101_Shifter —T
5 Sample200_WaveletCompressor et s W 4
Drag Tab
(i=0 r_length ; i++
Project . VA :
@ Console (21 Problems & Memory Allocaln ©2 @Bl v=d
Ex p | orer roject 'Sample001_PointByPointEcho’ Link successful
DSPL2ROM 1,049
DSPL2RAM . 262
DSPLIPRAM Other Windows 32768
DSPL1DRAM 32.768
SHDSPL2ROM 1,049%
SHDSPL2RAM 125Kk (68%) 182k
SHDSPL1PRAM 32.768
SHDSPLIDRAM 32768
EMIFACS3 33,554k
EMIFACS4 2,097k
EMIFACSS 2097k
>
If a window is not visible, go to View menu and select any window you may want:
% DSPProjects - Sample001_PointByPointEcho/mainc - Code Composer Studio - & x
File Edit |View  Navigate Project Run Scripts Window Help
e @ Resource Explorer |- - Quick Access| | 1 | 1B
@ Resource Explorer Classic
i3 Sam @ Getting Started Lrray - ’ ~
%Sem W CCS App Center n inFuncData_union inFuncDataArray;
B5am B qui compaser™ s o outFuncData_union outFuncDataArray;
= Sam
& som & Project Explorer )
& oo [ Problems AltaShiftsQ, X 1
& sam & Console AltsshiftsQ.C | Memwory Reserved for DHA and UART Operations
= 7 Advice
& sem G | [AUDTO_SAMPLES_MaX];
0 Memory Browser PI[AUDIO_SAMPLES_MAX] __attribute_((section(".ihséxterntien”)));
F[AUDTO_SAMPLES MAX] _attribute_ ((section(".ihsExterntlen”)));
Wt Registers
4 Expressions
™+ Variables Alt+Shift+Q vV
= Disassembly b1d)
% Breakpoints AltashiftsQ, 8
= Modules |
& Terminal " the bse
9 Scripting Console Ipling rate;
H Target Configurations Ffer_length;
& Outline Alt+Shift+Q, O
Stack Usage |t1a11ze0P();
~ Memory Allocation } the audio codec and its interfaces
® Optimizer Assistant
Other. AltsShifteQ, Q

1 1ength=AUDIO_SAMPLES_MAX;

19 buffer_length=10; //Should be less t

18 codecSettings_t codecSettings;

4 codecsettings. dnaFlog = CODECONFIG_NO_DMA;
/ arSattinas Amafla FONECONET?

s than or eq
qual to AUDIO_SAMP




Installing the Compiler:

After you have installed CCS, you will also need to install the C6000 Compiler Module. This module

contains the actual ¢ language compiler for the Tl family of DSP chips used by SignalMaster. CCS
will not be able to compile your code without that module.

1. Click Help > Install New Software:

¥ SignalMaster_DSPProjects - CCS Edit - Sample200_WaveletCompressor/main.c - Code Composer Studio

File Edit View Mavigate Project Run Scripts Window  Help

v 3 R v ds vl P viE[E @,:I Getting Started
CCS Developer Site
[ Project Explorer 52 BE% v =0 |[@manc: CCS Support

£ Calib202

5 SampleD01_PointByPointEcho
= Sample002_PointByPointEchoFilter
£ SampleD10_BlockEcho

= Sample011_BleckEchoFilter

= Sample020_CalibrationModule

0S5

= Sample100_Wavelet

CCS Videos and Tutorials

Help Contents
Search

Show Contextual Help

Show Active Keybindings... Ctrl+Shift+L
(5 Sample100_WaveletTEST e s,
£ Sample101_Shifter e
ea eets...
5 Sample200_WaveletComp [Active -
& Test_GPIO % (CCSApp Center
s
b(zTest_SGSpecs “y  Check for Updates
= TestinOut3
(S Wavelet 4t Install New Software...
B3 Installation Details
@ Eclipse Marketplace... "
v+ About Code Composer Studio
@ ] H .
2. For “Work with”, Select Code Generation Tools Updates:
&% Install o X
Available Software
Select a site or enter the location of a site. ).TJ

Workwit”| TTXIERTNED []| g

type or select a site.

--All Available Sites--

Code Generation Tools Updates - http://software-dl.ti.com/dsps/dsps p

DVT Updates - http://software-dl.ti.com/ccs/non-esd/dvt/cest.0

Name p: ti.com/codeg pg

https///software-dl ti.com/dsps/dsps_public_sw/sdo_ccstudio/codegen/Updates/p2linux/

@ T|https//software-diti.com/dsps/dsps_public_sw/sdo_cestudio/codegen/Updates/p2mac/
Spectrum Digital Emulation Updates - http://support spectrumdigital.com/ccs51/Updates

Code Composer Studio v7 Updates - http://software-dl.ti.com/ccs/esd/CCSv7/Updates

lsites" preferences.

typefilter t

Select All Deselect All

Details

Show only the latest versions of available software Hide items that are already installed

Group items by category What is already installed?
[ Show only software applicable to target environment.

Contact all update sites during install to find required software

@ <Back Next > Finish Cancel



3. Expand TI1 Compiler Updates, and then click the latest version of C6000 Compiler Tools. The
dialog window should look like the picture shown below.

o x
I
P
.t comdsps/atsps_public_swisdo_costudio/codegen/Updates/pawin3/ Add.. Manage-.
Versio
1699
18927
529
514
S0
495
a7
256
1813
1699
18127
6412
a2n
a110
606
5215
51
830 I
1 £6000 Compiler Toals 817 X
Select Al Deselect Al 1 item selected
Details
[ Show only the latest versions of available software [ Hide items that are already installed
Whnat s alrea
Gona

Note: Demonstration projects may have been compiled and supplied with a previous compiler
version. This should not be problem. Continue to select the latest compiler. The next section
will cover how to handle compiler discrepancies.

4. Click Next, then next again, then accept, then finish.




Updating Project Compiler Settings:

Chances are the latest compiler version has changed since we supplied the demonstration projects.
In this case the projects will by default throw an error “This project was created using a version of
compiler that is not currently installed...” . If this is the case, then we must update the project’s
compiler settings.

1. Right click the project in the Project Explorer window (A) and select Properties (B).
(A)

¥ DSPProjects - Code Composer Studio - o X
File Edit View Navigate Project Ryf Scripts Window Help

(SR Bitpv b ~iK v - v Quick Access|: & ||@
& Project Explorer " 0 [ mainc
~ & Sample001_PointByPaintEcho [Active - SF* "~ ~
r New >
& Binaries
i Includes Show in Local Terminal
> SM.V2 Add Files..
& codecConfig.c Copy Cti+C  pnd library patt
1 codecifh + Lh"
& Filterfunctions.c X Delete Delete |
& IHS_Utilities.c Refactor
< mainc Source > .
B Mainh ERROR_NOERROR;
% mcasp.c Rename... F2  FuncData_union inFuncDataArray;
i PROTOCOLK FFuncData_union outFuncDatsArray;
Impart >
Export. 1
53 Sample002_PointByPointEchoFilter Show Build Settings. bse External Memory for All Large Varist
& Sample010_BlockEcho Build Project E for DMA and UART Operations
&5 Sampled11_BlockEchofilter Clean Project W
IF¥ Sampied20_ CallbentionModula Rebuild Project MAX] _attribute_ ((section(".ihsExternilen”)));
5 Sample100_ Wavelet Refresh 5 fax] _attribute_((section(".ihsExternden®))};
5 Sample101_Shifter Close Project
I W S5
5 Sample200_WaveletCompressor .
Index >
Build Configurations > (B)
Debug As |
Restore from Local History-.
Team

Compare With
Properties Alt+Enter

2. Under General > Project > Tool-Chain > Compiler Version select the compiler version you just
installed or wish to use. The dialog option should look similar to the picture below.

W% Properties for Sample001_PoinByPointEcho ] X

General
Resource
General
+ Build Configuration: |SM_V2 [ Active ] ~| Manage Configurations...

~ C6000 Compiler

¥ Project mi Products

Device
Family:
Predefined Symbals
Advanced Options Vanant <select or type filter text> Generic C674x Device
C6000 Linker
€6000 Hex Utility [Disable
Debug
Tool-chain
Compiler version: Tv830 v More.
Output type:
Output format: eabi (ELF)
Device endianness: littie
Linker command file: | SM_V2.cmd Browse...
Runtime support library: | <automatic> Browse...
< >

v how advanced setting! Apply and Close Cancel

3. Click Apply & Close




Compiling A Project:

This process will generate an .OUT file which will then be used by the PC applications to program the
SignalMaster device with the DSP code you wrote. If no errors occurred while compiling, then the
.OUT file is automatically stored in the project folder by Code Composer.

Example .OUT file location:

C:\SignalMaster\DSPProjects\Sample001_PointByPointEcho\SM_V2\Sample001_PointByPointEcho.
out

1. Click the Build / Compile button.

Build Project

¥ DSPProjects - Sample001_PointByPointEcho/main.c - Code Composer Studio - 8 x
File Edit View Navigategmik gun Scripts Window Help
a ;w., i e i hecesl 8 |
" Project Explorer = 3 mainc
R R il Criar CrTUIUR = CAAUR_mEaRUn -

s

& Binaries extern union in ijon inFuncDataArray;

&) Includes extern union union outFuncDataArray;

SMV2

& codecConfig.c

n codecifh

& FilterFunctions.c

& IHS_Utilitiesc 0int Stim[2][AUDIO_SAMPLES_MAX];

& mainc int MicRv[2][AUDIO_SAMPLES_MAX] __attribute_((section(".ihsExternten")));

B Mainh short STest[AUDIO_SAMPLES_MAX] __attribute_((section(".ihsExterntem")));

& MCasp.c

A PROTOCOLh

& RingBufferfunc.c =
SM_V2.cmd int main(void)

& Sample002_Point8yP

& Sample010_Bio

& Sample011_BlockEchofilter

& Sample020_CalibrationModule int sampling_rate;

8 Sample100_Wavelet int buffer_length;

& Sample101_Shifter

& Sample200_WaveletCompressor

IHS_initializeDSP();

sampling rate=24000:



Loading and Running a Project:

After you have compiled your application, you are ready to load and run the file on the SignalMaster
hardware. You can load your programs using the SigMasLoader.EXE program. This program is
found in the SignalMaster installation directory.

Make sure that the SignalMaster hardware is connected to one of your computer’s USB ports and is
turned on. The top left LED on the box will start to blink when it is turned on and ready to accept a
program. If you do not see the LED blinking or if you need to reset the hardware at any time, you can
toggle the on/off switch until you see the LED blinking.

Use the select button to browse to the location of your compiled .OUT file. Then select the Load to
SignalMaster button to upload the program. The program will automatically start running.

% SignalMaster DSP Software Loading Module 1.00 - | x

CASignalMaster_DelphiProjects\SigMas_Loader\Calib101.out H Select |

Load to SignalMaster

Call Parameters: OUTFILEPATH&MAME [CLOSE] Program will automatically load file spedified in OUTFILEPATHEMAME (Mo spaces in Path allowed).
Optional [CLOSE] = Program will dose after loading.

Note: Although CCS provides an option to load and run programs directly from within CCS, you
cannot perform this option with the provided USB cable. Direct CCS hardware control and debugging
options requires the use of a special Joint Test Action Group (JTAG) cable. We do not recommend
using this option as it requires having your SignalMaster system hardware open. If you would like to
use a JTAG cable with your SignalMaster hardware, please contact IHS for further information.



Starting a New Project:

When generating a new SignalMaster DSP program, we recommend that you start out from one of
the provided examples that is most similar to what you want to accomplish and copy that project.

1. Simply right mouse click over the project you wish to copy and select the copy option on the
popup menu: &% SignalMaster DSPProjects - CCS Edit - Sample200 WaveletCompressor/main.c - Code Compe

File Edit View Mavgste Project Run Seripts Window Help
[=EL #rifr

ot Explorer 11 1 | (& maine £ (3] S Uitiesh

£ Calib202
L Sample001_PointByPointEcho [Active - SN
mtEchoFiter  Mew

GHERERESES

& B

5
]
b
1
s )
'
Restarefrom Local History. |
Team
Compare With

Propetties Alt-Enter

2. Now right mouse click over an empty region of the window showing the list of projects and
select paste from the popup menu:

¥ SignalMaster_DSPProjects - CCS Edit - Sample200_WaveletCompressor/main.c - Code G

File Edit View Navigate Project Run Scripts Window Help

> 2]~ Avigl
[P Project Explorer 52 % ¥ 0| @mainc 5t [ HS Utiitiesh
& calib202

(£ Sample001_PointByPointEcho [Active - SV

Eq21

£ Copy cec |
T Paste Ctrl+V
R Delete Delete

Import
Export.

Show Build Settings.
Build Project

Clean Project
Rebuild Project

3. Enter the name of your new project:

¥¥ Copy Project m] *

Project name: | MyProgram|

Use default location
C:\SignalMaster_DSPProjects\MyProgram Browse...

default



4. Your new program will now appear in the list of projects:

w+ SignalMaster_DSPProjects - CCS Edit - Sample20(
File Edit View Mavigate Project Run  Script

i BRI
[ Project Explarer 52 0% ¥ = 0
e A[ih20

1> MyProgram [Active - SM_V2]
Samplel01_PointByPointEcho

s

= SampleD0Z_PointByPointEchoFilter
£ SampleD10_BlockEcho
5 Sampled11_BlackEchoFilter

s

= Sample020_CalibrationModule

s

= Samplel100_Wavelet

£ Sample100_Wavel et TEST
fis]

= Sample101_Shifter
£ Sample20D_WaveletCompressor

Selecting a New Workspace:

During installation, CCS will ask you to select a Workspace Directory. We recommend that you use
the following Workspace Directory as the default:

C:\ SignalMaster\DSPProjects

If for any reasone, you need to have multiple work spaces, you can do this from the File menu, Switch
Workspace option.

&% SignalhMaster_DSPProjects - CCS Edit - Sompled10_BlockEcha/SM V2 cmd - Cade Camposer Studio
Fle Edit View Navigste Project Run Scripts Window Help

Hew S

Gpen File...
4 Open Projects from File System.

Close W
Close 40 CirleShifte W
™ Rename. [

Refresh ]
Convert Line Defimiters To

Switch Workspace
Restart

& Import..
s Espor

Properties AeEnter

15M_¥2.cmd [Sample010 BlockEcha]
2main.c [Sampledi0_BlockEcho)
3main.c [Samplel2 CalibrationModule]
dmain.c [Ssmpledl1_BlockEchoFiltes]
Bt

— — —



Code Composer Studio Compiler Settings (Advanced Options):

When you load one of the SignalMaster example programs into CCS, all required settings should
automatically be preset in the project files. This section is only provided for reference in case you
need to make any changes and so that settings can be verified.

Setting up the complier and linker options:

The following items are under the Project Menu, Properties Item:

Project Run Scripts Window Help
T4 New CCS Project {
@  New Energia Sketch...
i Examples... ’
Build Project
b Build Al CuleB |
Build Configurations s |
Build Working Set >
Clean...
Build Automatically
Show Build Settings...

|
] Import CCS Projects...
7] Import Legacy CCSv3.3 Projects...

C/C++ Index >

Properties

After selecting this option, a Properties dialog box will appear showing options for resources and
building your applications.

Make sure that the variable IHSC674xHW_DIR is declared and pointing to the SignalMaster
installation directory: C:\SignalMaster\IHSC674xHW where the hardware support libraries are
located. This variable is used in the projects in order to easily point to the directory where
SignalMaster has been installed containing all the required files.

7 Properties for Sample10_BlockEcho o x
Linked Resources [CRA RS

Path Variables  Linked Resources

file system, including other path variables with the syntax "S(VAR}".
y be specified relative to these path variables,

ampled10_BlockEcho's

Defined path variables for

6000 Compiler
6000 Lmk: Name Hew..
CB00D Hex Utility [Disabled] (£ CC5_BASE_ROOT Edit..
Debug (= CCS_INSTALL_ROOT
(= CG_TO0L ROOT mpiler\c6000_7.4.21 Remove
(= ECLIPSE_HOME Cit\cesvTheclipse\
2 THSCBTAW DR e CETAHW
(= PARENT_LOC CASignelMaster_DSPProjects
(= PROJECT_LOC CASignalMaster_DSPProjects\Sampled10_BlockEcho
(=TI PRODUCTS DR Gt
(=TI PRODUCTS DR_TIREX ~ C:\ti
(= WORKSPACE_LOC CASignalMaster_DSPProjects
® ‘

Make sure that the rest of the dialog windows are set as shown in the images below:



¥ Properties for Sample010_BlockEcho

typefifter text
~ Resource
Linked Resources
Resource Filters
General
~ Build
C6000 Compiler
C6000 Linker
C6000 Hex Utility [Disabled]
Debug

General

Configuration: | SM_V2 [ Active ] ~| Manage Configurations...

B Main =, Products

Device

Eemily: 6000

Voriant: Generic C674x Device v
Connection:

Verifyo | iapplies to whole project)
Manage the project's target-configuration automatically

Advanced settings

Compilerversion: 8| TIv74.18 [TIv7421] </ More.
Output type: Executable
Output format: eabi (ELF) -
Device endianness: | little v
Linker command file: | SM_V2.emd ~| | Browse..
Runtime support ibrary: | <automatic> || Browse
(@) show advanced settings Cancel

The Linker command file should be SM_V2.CMD - this file contains the memory map for the
hardware and other important parameters needed to compile your application.

5 Properte for Test AudiinOut Sampest
[T
Resource
Genenal
« Buid
B0 Compiler
Processor Optons
Optimization
Debug Optars
Inchude Options
Pertormance Adhisar
Aduanced Options
v CmLinkes
Bacic Options
File Serch Peth
Advanced Options
€809 Hex sty [Disabled]
Debug

Compiler Options:

Note that in the compiler and linker options, the path variable is shown in the include search path.

Basic Options

Confiquistion: | Debug [ Active] | | Manage Configurations.

‘Specily cutput file name (--output_file, -0) “S{ProjHlamelout

Set € system stack size[--stack size -stack] 800
Input and output sections listed inte <file> (--map. i, -m) “S{Projhamelmap’

Heap size for C/C » dynasmic memary allocation (+-heap_se, -heap) | 0200

Cancel

type filter text

Resource
General
~ Build
v C6000 Compiler
Processor Options
Optimization
Debug Options
Include Options
Performance Advisor
Advanced Options
€600D Linker
€600D Hex Utility [Disabled]
Debug

& Properties for SampleD10_BlockEcho

C6000 Compiler

Configuration: |SM_V2 [Active ] | Manage Configurations...

Command: ["sice_TooL cuy
i ine pattem: |

2 Siflags) S{inputs}

Summary of flags set:

bi -Ooff -g —-include_path="C:/ti/ccsv7/tools/ compiler/c6000_7.4.21/include” -

include_patt SignalMaster DSPProjects/Sample010_BlockEcho” --
include_patt SignalMaster/IHSCE74xHW/ include” —

include_patt SignalMaster/IHSCE74xHW/include/hw" -

include patt SignalMaster/|HSCE74HW/include/c674x" -«
include patt /748" -
include patt SignalMaster/| HSC674xHW/grlib” --

SignalMester/IHSC674xHW/ dsplib_c674x 3.4 0_0/packages’ -
include_path="C:/SignalMaster/IHSCE74HW/IHSLib* --gec —define=c6748 -define=IHS_SMV2 -
display_error_number --diag_ wrap=off diag_waming=225

Edit Flags..

See ‘General’ for changing ool versions and device settings

@)

Show advanced settings

Cancel

Make sure that the following are specified under the compiler options:



-mv6746 --abi=eabi -Ooff -g --include_path="C:/ti/ccsv7/tools/compiler/c6000_7.4.21/include" --
include_path="C:/SignalMaster_DSPProjects/Sample010_BlockEcho" --
include_path="C:/SignalMaster/IHSC674xHW/include" --include_path="C:/SignalMaster/IHSC674xHW!/include/hw" --
include_path="C:/SignalMaster/IHSC674xHW/include/c674x" --
include_path="C:/SignalMaster/IHSC674xHW/include/c674x/c6748" —
include_path="C:/SignalMaster/IHSC674xHW/grlib" --
include_path="C:/SignalMaster/IHSC674xHW/dsplib_c674x_3_4 0 _O/packages" --
include_path="C:/SignalMaster/IHSC674xHW/IHSLib" --gcc --define=c6748 --define=IHS_SMV2 —
display_error_number --diag_wrap=off --diag_warning=225

¥ Praperties for Sample010_BlockEcha o X
Include Options Svovw
Configuration: | SM_V2 [ Active ] | | Manage Configurations
Add dir to #include search path (--include_path, -I) 8 8 &

"S{CG_TOOL ROOTYi
“S{PROJECT_LOCY"
“S{IHSCE74<HW DIRY/
“S{IHSCG74xHW_DIR}/

w' [
de/c674x" [=]

€600 Linker "S{IHSC674(HW_DIRY
C6000 Hex Utility [Disabled] “S{IHSCE74xHW_DIR}/include/c674x/c6748" [
Debug "S{IHSC674cHW_DIR} grlib" [

“S{IHSCE74HW_DIRRIHSLib" [z

Specify a preinclude file (--preinclude) &
=
¥4 Properties for Sampled10_BlockEcho o x
€6000 Linker (SRR
Configuration: | SM_V2 [ Active ] ~ | | Manage Configurations..
Comman d: | *stea_tooL ety |

Command-line pattern: | S{command} Siflags} S{output_flag} Stoutput} S{inputs} |

Summary of flags set

e=c6748 -~define=IHS_SMV2 -~display_error_number -~
‘Sampled10_BlockEcho.map" -

G 7. "Gy p ) 7421/ include” -
i*C/SignalMaster/|HSCE74xHW/binary/c674x/cgt_ccs/utils/Debug” -
T gt Debug” -
C6000 Hex Utility [Disabled] e ; by :.' i (Z":‘ggmebug“ :
Y/ gt Pl -

E

Debug i"Cy
oC.

E

! gt 9
i plib_c674x_3_4_0_D/packag plib/lib" --reread_libs --warn_sections
diag_wrap=off --display_error_number -~mi_link_info="Sample010_BlockEcho_linklnfo.xm" --rom_model

Edit Flags...

See ‘General' for changing tool versions and device settings

(?)  Show advanced settings Cancel

Make sure that the following hardware specific paths are specified:

-I"${IHSSignalMaster}/IHSC6748HW!/binary/c674x/cgt_ccs/utils/Debug"
-i"${IHSSignalMaster}/IHSC6748HW/binary/c674x/cgt_ccs/c6748/drivers/Debug"
-I"${IHSSignalMaster}/IHSC6748HW/binary/c674x/cgt_ccs/c6748/system_config/Debug”
-i"${IHSSignalMaster}/IHSC6748HW/binary/c674x/cgt_ccs/c6748/lcdkC6748/platform/Debug"
-I"${IHSSignalMaster}/IHSC6748HW!/binary/c674x/cgt_ccs/grlib/Debug"

Linker Include Libraries:




&% Properties for SampleD10_BlockEcho

typefilter text File Search Path Eror -
» Resource

General
v Build Configuration: | SM_V2 [ Active ] ~ Manage Configurations...

 CE000 Compiler
Processor Options

Optimization i
Debug Options Include library file or command file as input (~library, -) 20858
Include Options “libc.a”

Performance Advisor utils lib
drivers.lib
> Advanced Options ey,

+ C6000 Linker system_config.lib
Basic Options griibib
File Search Path dsplib.lib

5 Advanced Options
CB000 Hex Utility [Disabled]

Debug ‘Add <dir» to library scarch poth (—carch_path, -1 8 858
*${CG_TOOL_ROOTYfinclude” [

"${IHSCE74xHW_DIR}/binary/c674x/cgt_ccs/utils/Debug" [
"${IHSCE74xHW_DIR}/binary/c674x/cgt_ccs/c6748/drivers/Debug" [

“S{IHSCE74HW_DIR) binary/c674x/cat ystem_

"S{IHSCE74cHW_DIRY binary gt ol
"${IHSCE74xHW_DIRY binary/c674x/cgt_ces/grlib/Debug” [=]
*${IHSC674cHW_DIR]\dsplib_c672 3_4_0_0\packages\ti\dsplib\lib" [

Debug” (=1

[ Search libraries in priority order (~-priority, -priority)
eread libraries; resolve backward references (--reread_libs, -x)

[ Disable sutomatic RTS selection (--disable_suto_rts)

(?)  how advanced setings Cancel

Make sure that the following libraries are shown:
“libc.a"

utils.lib

drivers.lib

platform.lib

system_config.lib

grlib.lib

¥¥ Properties for Test AudiolnOut1SamPerf

type filter text Build S

> Resource

General
~ Build Configuration: | Debug [ Active ] ~ EManage Configurations.

~ CB0DO Compiler
Processor Options
Optimization 5 Builder Behaviour = Steps |u Variables P Environment G Link Order e[ Dependencies
Debug Options
Include Options
Performance Advisar

Builder
e default build command

> Advanced Options Build command: | ${CCS_UTILS DIRYbin/gmake -k Variables.
5 €60DD Linker

C6000 Hex Utility [Disabled] Makefile generation
Debug enerate Makefiles automatically Expand Env. Variable Refs in Makefiles

Build location

Build girectory: | S{warkspace_loci/Test_AudiolnOutiSamPerf)/Debug

Workspace.. Variables..
See ‘General for changing tool versions and device settings
() show advanced settings Cancel
¥ Propeties for Test_AudiolnOut!SamPerf o x
type filter text Build D
> Resaurce
General
« Build Configuration: | Debug [ Active ] || Manage Configurations...

v C6000 Compiler
Processor Options
Optimization [ Builder @ Behaviour % Steps [ Variables P Environment % Link Order I3 Dependencies
Debug Options
Include Options Build settings
Performance Advisor [ 5top on first build error [JEnable parallel build

Use optimal jobs (8)

> Advanced Options

> 6000 Linker Use paralleljobs: |8 %
C6000 Hesx Utility [Disabled] Use unlimited jobs
Debug Werkbench Build Behavior
Workbench build type: Make build targe:
uild on resource save (Auto build) | all || variables...
Note: See Workbench automatic build preference
uild (Incremental build) [an || variables.
lean [ clean | | variables...

See 'General' for changing tool versions and device settings

@) e Conee




% Properties for Test_AudiolnOut1SamPerf a X

type filter text Build G
Resource
General |

- Configuration: | Debug [ Active] ~| | Manage Configurations

Optimization = Builder (@) Behaviour

Variable Value Origin Add..
CCS_IAVA_HOME Citi\cesvTieclipsére  BUILD SYSTEM =
CCSUTILS DIR CatileesyTutils BUILD SYSTEM

o Disabled wp r Project.. USER: CONFIG

ex Uty [Dizablec] PWD oject..  USER: CONFIG
Debug
(® Append variables to native environment
(O Replace native environment with specified one
See ‘General for changing tool versions and device settings
@ e

Note that in the above image, CCS_UTILS_DIR shows, C:\ti\ccsv7\utils — the ccsv7 is a reference to
the version (version 7) of CCS that was installed at the time the image was generated. If you have
installed a later or earlier version of CCS, that string may read ccsv8 (for version 8). This will not
affect the compilation of your program.

Other tabs: Steps, Variables. Link Order and Dependencies should be blank.

Project Menu:
Properties...
Include Options — make sure that the correct directory is shown in the path



Developing PC Applications:

PC applications can be developed in any programming language that allows the use of a DLL.
These include all high level languages such as C++, Pascal and Visual Basic. Other programming
environments such as Matlab and LabView also allow the use of DLLs. The DLL provides routines to
load programs to the DSP and to communicate with the DSP during execution. For a full list of DLL
commands and data types, see the IHS SignalMaster DLL Commands section below.

Every PC application will need to use DSP program. The DSP program receives commands
from the PC and either uploads data from the PC or downloads data to the PC at the PC’s request.
Applications can be written to present sounds at different frequencies and intensities and record from
the DSP microphones. The DSP can also work independently and automatically process the
microphone signals and output them back through the earphones. The PC can also simply provide
processing parameters to adjust band pass filters to change the processing and characteristics of
signals being presented to a subject.

After setting up the DLL declarations in your program as shown in the IHS SignalMaster DLL
Commands section below, you will be able to load DSP programs and start sending commands and
data to the DSP.

First load the DSP code by calling the SM_Initialize routine specifying the location of the .OUT
file that is generated by the TI Code Composer Suite (CCS) (See Tl Code Composer Studio Setup
section below). Make sure that both the our2sprc.exe program and SIGMAS.DLL are in the same
directory as your application.

SM_Initialize(*C:\MyPath\MyDSPProgram.OUT’);
You may also program a DSP application with all processing parameters coded within the DSP code
and not use a PC program. In this case, you can simply load a DSP application by running the
SigMasLoader.EXE program (See the Loading Programs to the DSP section below for additional
information).

Sending Function Calls and Data to the DSP:

Data may be sent to DSP using one of several arrays types defined in the SignalMaster DLL.
To transfer bytes, simply use a byte array (TxArray in this example). You can load the values into the
array:

TxArray[1]:= valuel,
TxArray[2]:= value2;

forray[n]:: valuen;
Then call the SM_PutByteArray command specifying the array and number of bytes.
SM_PutByteArray(TxArray,n);
You may also use a Short Integer (16 bit) and Integer (32 bit) type arrays with their corresponding
Z?t”esr. you perform the transfer call, the data is sent to the DSP, but you need to let the DSP know that

it has data waiting to be process, so you will need to implement a function call:

SM_DSPFuncTx(MyFunctionNumber, n);



Where MyFunctionNumber is a function that you have defined in your DSP code and n is the number
of bytes that the function will read. Make sure that the number of bytes (n) matches the actual
number sent.

Requesting Data from the DSP:

To request data from the DSP, you will need to call another function you have defined for that
purpose:

SM_DSPFuncTx(MyFunctionNumber, n);

In this case, n can be equal to 0 if you are not sending any parameters to that function. In some
cases, you might want to read data from one microphone or another, you may specify the microphone
number by first call filling in the corresponding data array and then transferring the parameters using
the SM_PutByteArray(TxArray,n) function before calling the DSP function as done in the previous
example.

After the function call, read the data by first calling:
n:=SM_DSPFuncRx(MyFunctionNumber);

The function will return the number of bytes (n) transferred by the DSP. Note that if you call multiple
data request function calls without calling the SM_DSPFuncRx receive function, the previous data
requests will be discarded.

After the SM_DSPFuncRX, you will need to transfer the actual data from the DSP to the PC
application. Simply call the corresponding SM_Get function corresponding to the data type you wish
to read:

SM_GetIntArray(RxArraylint,(n/4));

In the above example, the Integer array RxArrayInt will be filled with n integers of data. Important
note: The SM_DSPFuncRx function returns the number of bytes transferred, however, the SM_Get
functions will read the number of data points for the corresponding data type. In this example, the
data type is integer (32 bits = 4 bytes), therefore n is divided by 4 when calling the SM_GetIntArray
function.

With these basic command, you will be able to develop complex applications that call on the
SignalMaster DSP to perform any number of functions you define and transfer data to and from the
DSP. Several PC application source code examples are provided in the PCProjects subdirectory
under the various programming languages. Although currently all the examples are provided in
Delphi Pascal, additional examples in other languages will also be provided soon.

IHS SignalMaster DLL Commands:

Type Declarations:
ArrayType = Array[1..40000] of Byte; //Byte Array
ArraySintType = Array[1..20000] of Smallint; //Small Integer Array (16 Bits)
ArrayIntType = Array[1..10000] of Integer; /llinteger Array (32 Bits)



HeaderType = Array[1..8] of Byte;

Functions:

Name: Returns: Description:

SM_DLLVer PANSIChar | Returns a pointer to an array of characters
with the version of the dll in use.

SM_ Initialize(DSPProgram:ShortString) Integer Initializes the SignalMaster system and
loads the DSPProgram OUT file.

SM_Close Integer Closes SignalMaster system and resets
Bootloader to wait for next program
upload. If you terminate an application
without calling this function, you will need
to turn your SignalMaster system off and
on to reset the bootloader. Otherwise, you
will not be able to load another application.

SM_DSPFuncTx(FuncNum,Count:Integer) | Integer Calls a user defined or IHS predefined
DSP function number FuncNum to send
data to the DSP. Counter specifies the
number of bytes passed as parameters for
use by the function.

SM_DSPFuncRx(FuncNum:Integer) Integer Calls a user defined or IHS predefined
DSP function number FuncNum to recieve
data to the DSP. The returned integer
specifies the number of bytes passed to
the PC from the DSP.

SM_GetByteArray(var A:ArrayType; Integer Download Count bytes from byte array.

Count:Integer)

SM_GetSIntArray(var A:ArraySIntType; Integer Download Count bytes from Small Integer

Count:Integer) (16 bit) array.

SM_GetIntArray(var A:ArrayIntType; Integer Download Count bytes from Integer (32

Count:Integer) bit) array.

SM_PutByteArray(var A:ArrayType; Integer Upload Count bytes from byte array.

Count:Integer)

SM_PutSIntArray(var A:ArraySIntType; Integer Upload Count bytes from Small Integer (16

Count:Integer) bit) array.

SM_PutintArray(var A:ArrayIntType; Integer Upload Count bytes from Integer (32 bit)

Count:Integer)

array.

Implementation:

var
hdll:THandle;

Const
SIGMASDLL = 'SIGMASDLL.dII'#0;

Type

ArrayType
ArraySintType
ArrayIntType
HeaderType

= Array[1..40000] of byte;
= Array[1..20000] of Smallint;
= Array[1..10000] of Integer;
= Array[1..8] of byte;




Function SM_DLLVer:PANSIChar; cdecl; EXTERNAL SIGMASDLL;

Function SM_ Initialize(DSPProgram:ShortString):Integer; cdecl;, EXTERNAL SIGMASDLL;

Function SM_Close:Integer; cdecl; EXTERNAL SIGMASDLL,;

Function SM_DSPFuncTx(FuncNum,Count:Integer):Integer; cdecl; EXTERNAL SIGMASDLL;

Function SM_GetByteArray(var A:ArrayType; Count:Integer):Integer;  cdecl; EXTERNAL SIGMASDLL;
Function SM_GetSIntArray(var A:ArraySIntType; Count:Integer):Integer; cdecl; EXTERNAL SIGMASDLL;
Function SM_GetIntArray(var A:ArrayIntType; Count:Integer):Integer; cdecl; EXTERNAL SIGMASDLL;
Function SM_PutByteArray(var A:ArrayType; Count:Integer):Integer;  cdecl; EXTERNAL SIGMASDLL;
Function SM_PutSIntArray(var A:ArraySIntType; Count:Integer):Integer; cdecl; EXTERNAL SIGMASDLL;
Function SM_PutIntArray(var A:ArrayIntType; Count:Integer):Integer; cdecl; EXTERNAL SIGMASDLL,;
Function SM_DSPFuncRx(FuncNum:Integer):Integer; cdecl; EXTERNAL SIGMASDLL;

var
TxArray . ArrayType;
TxArraySInt : ArraySintType;
TxArraylnt  : ArrayIntType;
RxHeader : HeaderType;
RxArray : ArraySIntType;
RxArraySint : ArraySIntType;
RxArrayint  : ArrayIntType;

/IYou must first initialize the DLL on your application...
procedure TAudioANC.FormCreate(Sender: TObject);
begin
Hdll:=0; //Initialize...
Hdll:=LoadLibrary(PChar('SIGMASDLL.dII'#0));
If HdII=0 then ShowMessage('Error Loading IHSInterface DLL Library");
end;



Developing DSP Applications:

To modify the DSP code provided or develop your own applications, you will need to use the Tl Code
Composer Studio (CCS). Instructions are provided in the TI Code Composer Studio (CCS) Setup
section on how to set up CCS on your computer. Please make sure you follow the CCS setup
instructions very carefully. Additional information is also provided from Tl documentation. IHS code
examples are provided in the distribution thumb drive, in the DSPProjects subdirectory and from the
SignalMaster webpage.

At this point you should have already installed CCS and selected a Work Space directory. We
recommend using C:\ SignalMasterProjects. You should have also Imported the samples provided by
IHS into your work space directory.

The easiest way to start a new DSP application is to look for one of the examples provided by IHS
that is most similar to the application you want to develop. In CCS, simply right mouse click on the
application you want to copy, and press copy from the drop down menu:

¥¥ SignalMaster_DSPProjects - CCS Edit - SampleD10_BlockEcho/SM_V2.cmd - Code Composer Studio W% SignalMaster DSPProjects - CCS Edit - Sample010_BlockEcho/SM_V2.cmd - Code Composer Studio

<

(£ sampleD10_BlockEcho

Build Configurations

Debug As
Restore from Local History...
Team

Compare With

Properties

File Edit View Navigate Project Run Scripts Window Help File Edit View MNavigate Project Run Scripts Window Help
Ami IBiIRiDitpvig v AERER NOR S Lo =T e R R v Do
[Fs) P:Jm Explorer 52 =& =0 Elozme  [E codecConfig.c [&) main.c ) Project Explorer 52 HE = 8| [ mane [&] codecConfig.c [&) main.c B
g Calb100 p6 -xtack xiooe (£ Calib100 16 -stack @x1e6@
(= Calib100Pnt 17 -heap @x1866 5 Calib100PRE 17 -heap @x1080
 Calib10] 18 #define bootloaderLength Bx13860 z all n 5 #define bootloaderLength 213800
b et 19 #define bootloaderStart x11800008 £ Calib10l 19 EdeFine boot loodorStact 1500608
é Cal‘baoz - :SE?"E SHDEZLZLWLSHE ?’;BB?‘{BB:B i Calib102 20 #define SHDSPL2RAM SIZE 9xB0840000
ali 21 #define appStar ootloade s - : -
(S COMPRESSOR 22 #define applength (oxBov40aa g Ez‘n:é?aagssm 21 faetine appstart g;°;;;ﬁ;;§g5t
% rouauze 25 22 #define appLeng X -
: - 24 MEMORY 5 EQUALIZE
v [ Sample010_BlockEcho [Active - SM V21 o > £Ql . 4 MEMORY
» v £ Sample010_BlockEcho [Active - SM_V2] -
3%, Binaries New > jovesees 1 = * p;
inaries . - -
g - :
& Includes . Joseeese 1 = i DSPL2ROM 0 = 0x@B708080 1 = GxE
@ sMv2 Show in Local Terminal > Joceooee 1 = ! Includes DSPL2RAM: 0 = Ox00BEE0REE 1 = OxE
[ codecConfig.c Add Files... lereeoee 1 = = sMv2 DSPLIPRAM: o = BxDOE@BOB® 1 = OXE
codecith l1700080 1 - g codecConfig.c DSPLIDRAM: o = GxBOF@B080 1 = OxE
[ Copy CuleC  )Start 1= decith SHDSPL2ROM: o = Gx11788080 1 = OxE
[ FilterFunctions.c Pt = l1Ee0000 1 = thi codecit. SHDSPL2RAM: o = appStart 1= app
[ HS_Utilities.c aste Y lireeese 1 = g} FilterFunctions.c SHDSPLIPRAM: o = Bx11E0G@0 1 = OXE
[ main.c 3 Delete Delete  }2828660 % = [} IHS_Utilities.c SHDSPLIDRAM: o = GX11F@B080 1 = OxE
K| Main.h [teaeeee 1 - . 0 1 = ox€
an Refactor ’ jcoaceoe 1 = Le| main.c New > _
mcasp.c Main.h 18 1 = exe
g} measp. Source > L) Main. oo 1 = oxe
PROTOCOLA Vowe [8 measp.c Show in Local Terminal >
[ RingBufferFunc.c PROTOCOLh
 Lir SMV2emd Loz F2 [ RingBufferFunc.c Add Files... lons wholly
&5 Sample011 BlockEcheFilter — N  SM_V2.cmd Copy CtieC  fons [ L
Li Sample020_CalibrationModuli Boort (% Sampled11_BlockEchoFilter S e &+ Copy Project [m] x
5 Test_AudiolnOutiSamPerf =1 Bt (£ Sampled20_ CalibrationModul
T Teet GPIO o Build St lospLoram = Sample020_CalibrationModule R Delete Delete
2 ow Build Settings... i -
(5 Teot SGBandPasses g bip<pi2Ram = Test_AudiolnOut1SamPerf - N Project name: | MyProgram
3 i
[ Test_SGFFTWavelethL Gain Build Project jHDSPL2RAN % Test GPIO Lram
55 Tect SGNoiseCancel Clean Project JHDSPL2RAN (£ Test_sGBandPasses Source > l2rAM Use default location
s [HDSPL2RAM (£ Test_SGFFTWaveletNLGain Move... [2Ran
(5 Test SGSpecs Rebuild Project k -
s [HDSPLZRAN [ Test_SGMoiseC. | [2Ran CA\SignalMaster_DSPProjects\MyProgram Browse
(£ Test_SGStimLoop Refresh F5  HDSPLZRAM L. JestSGMNaisetance Rename... F2 |opam =g A= P A SR S e, ST
(5 TestinOut3 SHDSPLZRAM (&> Test SGSpecs oram
55 Wavelet Close Project iHDSPL2RAM (5 Test_SGStimLoop Import > [oram default
Make Targets JHDSPL2RAM (£ TestinOut3 iy Bxport. 12RAM
JHDSPL2RAM A = LorAM
Index > JHDSPL2RAM i~ Wavelet
Show Build Settings... L2rAmM
qurati Loram
Build Configurations > | Build Project 2w |
Debug As > e = Memorya Clean Project =
Restore from Local History... Rebuild Project !
Team > Refresh F5  |Memory Alloc
Compare With > Close Project
Properties Alt+Enter Make Targets
©eunenisAnr
Index

Alt+Enter

Starting a new DSP project: 1) Right mouse click on desired project and select copy, 2) Right mouse click on open area
of Project Explorer (Left Panel) and select Paste, 3) Enter name of new project.

You code should be primarily limited to the main.c file. Other files and libraries contain important files
that if modified could affect the function of the DSP and other project using the same file.



In the Main.C file, the DSP application has two main areas of code:

1) Initialization
2) While Loop

1) The initialization code is used to set up all the important parameters, registers and variables
needed for the DSP to operate. Most of the important hardware components are initialized in the
procedure: 1HS_initializeDsP(); , but others require your attention as shown in the code example
below (Sample010_BlockEcho). 2) The main application While loop is where all the work is done
while your application is running. The main application While is subdivided in to 2a) a region used to
monitor commands from an external program and 2b) a region used for data acquisition, output and
signal processing.

Therefore, your DSP application source code should focus primarily in the main While loop in the
Main.C file. This loop deals with receiving function calls from the PC program and sending and
receiving data based on your define function calls. After the DSP code is loaded into the system, the
DSP waits in an infinite loop (see the sample source code below) for instructions from the host PC
and for hardware interrupt notifications that data is ready to be processed. All DSP programs should
contain code as shown in the example below:

Sample010 BlockEcho:

/*
TEST APPLICATION
*/

#include "main.h"
//Added include directory and library path
#include "ti\dsplib\dsplib.h"

//Error
unsigned char errorNum = ERROR_NOERROR;
//Control Array

extern union inFuncData_union inFuncDataArray;
extern union outFuncData_union outFuncDataArray;
f ] = e

// User Define Variable - Use External Memory for All Large Variables
// Internal Memory Reserved for DMA and UART Operations

int Stim[2][AUDIO_SAMPLES MAX] __attribute__((section(".ihsExternMem")));
int MicRv[2][AUDIO_SAMPLES MAX] __attribute__((section(".ihsExternMem")));
short STest[AUDIO SAMPLES MAX] __ attribute__((section(".ihsExternMem")));

int main(void)

{

int sampling_rate;
int buffer_length;



IHS_initializeDSP();

//Setup the audio codec and its interfaces

sampling rate=24000;

//sampling_rate=48000;

buffer_length=AUDIO_SAMPLES MAX; //Should be less than or equal to AUDIO_SAMPLES_ MAX
buffer_length=600; //Should be less than or equal to AUDIO SAMPLES_ MAX
codecSettings_t codecSettings;

codecSettings.dmaFlag = CODECONFIG_USE_DMA;

codecSettings.samplingRate = sampling_rate;

codecSettings.wordSize = WORD_SIZE;

codecSettings.gainMicLeft = 0; /* 0 to 47.5 */

codecSettings.gainMicRight = 0; /* 0 to 47.5 */

codecSettings.gainHeadphonelLeft = -6; /* -6 to 29 */
codecSettings.gainHeadphoneRight = -6; /*¥ -6 to 29  */

codecSettings.gainLineoutRight = Q; /* -6 to 29  */

codecSettings.gainLineoutlLeft = Q; /* -6 to 29  */

[/ === m s m oo oo oo oo

//PC Function Call Variables...
unsigned short FuncNum;
unsigned int  FuncDatalLength;

//Misc variables
int i;
int n=1;

LED(0,1);
delay ms(100);

for(i=0 ; i<AUDIO_SAMPLES_MAX; i++)

{
stim[@][i] = ©;
stim[1][i] = o;
}
J = m e e e e e

//Initialize Output

audio_writeTxBuffers(&Stim[0][0], &Stim[1][@], buffer_length);
int32_t result = IHS_initializeCodec(&codecSettings, buffer_length);
I2SDataTxRxActivate(&codecSettings);

LED(9,0);

while(1)
{

if(PCFunction(&FuncNum,&FuncDatalLength))
{

switch(FuncNum)

{

case 201://Send Right Mic to PC
for(i=0 ; i<buffer_length ; i++)
{

}
sendDataVIARingBuffer (201, outFuncDataArray.asUChar, buffer_length*4);

outFuncDataArray.asInt[i] = (int) Stim[@][i];



break;
case 202://Send Left Mic to PC
for(i=0 ; i<buffer_length ; i++)
{
outFuncDataArray.asInt[i] = (int) Stim[1][i];

}

sendDataVIARingBuffer (201, outFuncDataArray.asUChar, buffer_length*4);
break;

default: //Undefined Funciton Call from PC - Return Error Message back to PC

PCFunctionSendError (ERROR_PROCO_UNDEFINED_FUNCTION_RX);

break;
}
}

[ == m e e e e e e e e e e e e e e e e e e e e oo
//Check if Audio Buffers are Ready and start processing...
AR e R L
if(audio_checkForRx())
{

[ == m e e e e e e e e e e e e e e e e e oo

//Scrolling LED Display

R R e

LED(n,0);

n++;

if (n>4) { n=1; }

LED(n,1);

J e il

//Setup Buffer Pointers - REQUIRED

[ == m e e e e e e e e e e e e e oo

audio_updateBuffIndex();

[ == m e e e e e e e e e e e e e oo

//Read Last Buffer

R e L L L PR

//audio_receive(&MicRv[0][0], &VicRv[1][@], buffer_length);
audio_receive(&Stim[0][0], &Stim[1][@], buffer_length); //Enable to Echo

audio_send(&Stim[0][0], &Stim[1][0], buffer_length);



Sample DSP Programs Provided:

The following example DSP programs are provided:

Sample Name:

Description:

Sample001_PointByPointEcho

Acquires data on a point by point basis based on the selected
clock rate and outputs same point to speakers.

Sample002_PointByPointEchoFilter

Acquires data on a point by point basis based on the selected
clock rate, applies filters and outputs same point to speakers.

Sample010_BlockEcho

Reads a block of data from the microphones and outputs the
blocks to the speakers.

Sample011_BlockEchoFilter

Reads a block of data from the microphones and outputs the
blocks to the speakers after applying IIR filters. Weight
constants can be added to the filter banks to provide different
gain factors for each bank. This would be similar to a linear
analog hearing aid.

Sample020_CalibrationModule

Generates calibration tone and outputs through speakers. Also
reads data through microphone for analysis. This application
can be used with

Sample100_Wavelet

Reads a block of data and performs an FFT. The FFT can be
weighted to adjust the outputs of each bin. An iFFT is
preformed and the result outputted. An overlapping window
scheme is used compensate for window-to-window amplitude
difference and edge effects. This program can be used with PC
application — SigMasEqual.EXE in folder
\PCProjects\Delphi_Pascal\SigMas_Equalizer

Samplel01_Shifter

Acquires a block of data, performs FFT and does a frequency
shift of components, then performs iFFT to generate time
domain output. Resulting sound output has a remapping of
frequency components. This program can be used with PC
application — SigMasEqual.EXE in folder
\PCProjects\Delphi_Pascal\SigMas_Equalizer. You will need to
modify the source code to load this OUT file instead of the
default Sample100_Wavelet.out

Sample200_ WaveletCompressor

Performs compressor algorithm for HA applications with two
transfer functions. Performs a 128 point FFT, selects the
appropriate transfer function based on the sound level, attack
and release timing of each frequency band, and perform an
iFFT in less than 5.33 msec for both ears. This program can be
used with PC application — SigMasComp.EXE in folder
\PCProjects\Delphi_Pascal \SigMas_Compressor




Debugqging DSP Programs:

The easiest method to debug your DSP applications is to develop your function calls one at a time
and make sure they return specific values that you can check to make sure they are functioning as
expected. You can also turn the LEDs on your device on and off in order to monitor the progress of
your application as the execution move from one routine to another.

To turn ON an LED calll:

LED(n,1); // Where n=LED number (1-4)

To turn ON ALL LEDs call:

LED(0,1); // Turns on ALL LEDs (1-4)

To turn OFF an LED call:
LED(n,0); // Where n=LED number (1-4)

To turn OFF ALL LEDs call:

LED(0,0); // Turns OFF ALL LEDs (1-4)

Note: Although CCS provides the ability to do live debugging of code during the development process
from the compiler, this feature is not directly available in the enclosed SignalMaster product ver 2.00.

Loading Programs to the DSP:

After you have developed your own DSP applications, you can load your programs on to the DSP
using the SigMasLoader.EXE program. The source code for this program is provided in the
PCProjects\Delphi_Pascal\SigMas_Loader subdirectory. The program uses the DLL to call the
SM_ Initialize routine to load the corresponding DSP compiled program (OUT File). When you run
this program, it will ask you to select the DSP program you want to run.

2 SignalMaster DSP Software Loading Module 1.00 - | >

|C:\SignaIMaster_Dt:IphiF"rujects'-.SigMas_Luader'-.CaliM 01.out ‘ | Select

Load to SignalMaster

Call Farameters: OUTFILEPATHEMAME [CLOSE] Program will automatically load file spedfied in OUTFILEPATHEMAME (Mo spaces in Path allowed].
Optional [CLOSE] = Program will dose after loading.

You can also call this program from another application using call parameters. The first parameter
should be the path and name of the DSP compiled program you wish to load. For example, if you
wish to run the program, MyDSPProgram.OUT, you can call: “SigMasLoader.EXE
C:\MyDirectory\MyDSPProgram.OUT”. This will automatically load that program. If you also want to
close SigMasLoader after loading the program, simply add [CLOSE] as a second parameter:
“SigMasLoader.EXE C:\MyDirectory\MyDSPProgram.OUT [CLOSE]’. When passing parameters to
another application, remember not to use spaces in the file path or file name. Spaces indicate a new
parameter and will result in the loading program not being able to find you DSP program.



SignalMaster Ver 2.00 Specifications:

Processing Family:

Processing Speeds:

Codec:

Memory:

Data Sampling Rate:
PC Communication:
Analog Input:
Analog Output:

Texas Instrument TMS320C6746 32/64 bit floating point processor.

For complete datasheet, visit:
http://www.ihsys.com/ohsspds/signalmaster/tms320c6746.pdf

The TMS320C6746 is capable of performing 2100 million floating point
operations per second (MFLOPS) with a 2.8 ns cycle time

TLV320AIC3254 Ultra Low Power Stereo Audio Codec with imbedded
miniDSP. For additional information, visit:
http://www.ihsys.com/ohsspds/Documents/slaa408a.pdf

256KB (Kilo Bytes) of internal memory and addressing lines providing access
to 4MB (Mega Bytes) of external asynchronous memory.

Programmable with rates from 8 to 96kHz.
USB & Ethernet
Microphone inputs with stereo drivers & A/Ds (programmable 16/20/24/32 bits)

Stereo headphones outputs with drivers & D/As (Programmable 16/20/24/32
24 bits)

Universal Asynchronous Receiver/Transmitter (UART) communication modules: The system

LEDs:

Power Supply:
Battery:

Size:

Weight:

provides a USB/Serial communication and EtherNet UARTSs for data exchange
with a PC for programming, parameter selection and data exchange.

Battery power indicators and programmable logic indicators.

Options to run off battery or A/C power adaptor.

ICR18650 Li-lon 2 X 3.7 V 2600 mAh (10 hours) (1.67 oz each)
190 mm X 90 mm X 30 mm
<8 oz

Photo of SignalMaster device showing dual
microphones and stereo headphones
connected to the system. The system can
use any standard 8-12 ohm headphones.



http://www.ihsys.com/ohsspds/signalmaster/tms320c6746.pdf
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Photo of inside of SignalMaster enclosure showing DSP circuit board, battery charging
circuit board, power switch, and power, microphone, headphone connectors.

USE EXTREME CAUTION WHEN OPENING THE SignalMaster ENCLOSURE
Sensitive electronic components can be damaged by electrostatic discharge.
Do not mishandle or damage Lithium-lon batteries.

Do not ship system if batteries are damaged.

Follow all Lithium-lon battery shipment regulations.

Fire Hazard if batteries shorted, mishandled or damaged!

A CAUTION

LITHIUM ION or LITHIUM POLYMER
9 if RECHARGEABLE BATTERIES INSIDE

Do not damage or mishandle this package.

If package is damaged, batteries must be quarantined,

inspected and repacked.

For additional information, call:

IF DAMAGED Intelligent Hearing Systems Corp.
HANDLE WITH CARE 1-800-447-9783




Technical Support:

For any questions or technical support with your SignalMaster system, email: support@ihsys.com

Please make sure to enter “SignalMaster Support” in the subject line and the serial number of your
system.



mailto:support@ihsys.com

